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Autograph and Technology in the Mathematics Classroom

This document has been produced by Daniel Rodriguez-Clark of www.interactive-maths.com

It is intended as a guide to using Autograph in the classroom as an aid to teaching mathematics. The ideas in this guide have come from a variety of people and courses, and I do not claim that all the ideas are my own. The resources provided in the resources column link to a variety of documents (some of my creation, some created by others) and websites.
Although this document is designed to be helpful on its own, the resources that are linked to are often more useful and give ideas for further exploration. As such, this document should be used in conjunction with these additional materials.
The descriptions I provide of how to do things are a part of this guide. However, the main aim is to enable teachers to think about the ways they can make use of the software in their classroom, and to think about the questioning that goes along with that.
Some of the biggest contributors have been:
· Craig Barton (www.mrbartonmaths.com)
· Douglas Butler (www.tsm-resources.com) and the fantastic TSM Conference
· Alan Catley (http://www.kangaroomaths.com/free_resources/autograph/index.html)
[image: ][image: ]This document is clearly aimed at making the most of technology in teaching mathematics. If you would like to find out about some other activities that do not rely on technology, then check out my eBook “50 Great Activities for Any Classroom”. 
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	[bookmark: _Toc375131618]INTRODUCTION TO AUTOGRAPH
	Resources

	[bookmark: _Toc375131619]Autograph Buttons – The Basics
· [image: Cursor] the Select/Marquee Select button is the most basic mode in Autograph. It is used to select things and move them, and for right clicking to access the menus. This mode can be accessed by pressing “Esc” on your keyboard at any time.
· [image: mode-point 24 h p] the Add Point mode is how we add points as coordinates directly to the page, or vertices for shapes.
· [image: add-equa 24 h p] the Enter Equation button is very useful to enter the equation of any graph. However there is a shortcut to open this box by simply pressing the return (enter) key.
· [image: page-new 1d 24 h p] the New Statistics Page, [image: page-new 2d 24 h p] New 2D Graph Page and [image: page-new 3d 24 h p] New 3D Graph Page are used to open a page of the type you want.
· [image: axes-edit 24 h p] the Edit Axes button allows you to change the settings of the axes (appearance as well as scale and labels).
· [image: textbox 24 h p] the Text Box creates a text box to input any text in. If you click it with an object selected, it will automatically populate the text box with the relevant information (coordinates for a point, equation for a graph, etc).
· To access the menu of actions you can take on an object or a group of objects, select them and right click. At the bottom of the box that appears is a list of possible actions.
	· Introduction to Autograph Video
· Edit Axes Video

	[bookmark: _Toc375131620]Autograph Buttons – Really Useful Buttons
· [image: Default Scale] the Default Scale button will adjust the scale to fit the graph as best as possible.
· [image: axes-equalaspect 24 h p] the Equal Aspect button ensures that both axes are to the same scale.
· [image: Whiteboard Mode] the Whiteboard Mode setting, which makes all the lines a little thicker, and allows you to select multiple items by just clicking on them one at a time.
· [image: Keyboard] the onscreen Keyboard which pops up and allows you to not only enter equations from the board, but also has symbols for many common mathematical symbols which can be used in any program. This can also be opened independently of Autograph from the Start menu.
· [image: Slow Plot] the Slow Plot function, that can be used to plot a graph slowly, starting from negative x values.
· [image: Constant Controller] the Constant Controller which allows you to adjust constants in equations to see what happens.
· [image: Scribble] the Scribble pen which allows you to write all over the Autograph screen, and easily mark predictions.
· The Status Box appears at the bottom of the screen, and displays all relevant information for the current selection (such as lengths, angles, equations, coordinates, etc). It is quite small, but can be easily enlarged by double clicking on it.
· Under View->Preferences and then the “General” tab there are 2 important options. The first is how to change between Standard and Advanced Level. The second is the Accuracy that will be used in numbers.
	· Autograph Keyboard Video

	[bookmark: _Toc375131621]Autograph Pedagogy
· Always get the students to predict what they think will happen. This is probably the single most important aspect of using Autograph (or any other software). This gets the students to think about what will happen, rather than just blindly look and accept. Never forget this.
· Get students to write their answers down. This could be on a mini-whiteboard, the back of their books, or a scrap of paper, but it gets them to formalize what they want to say, and use mathematical notation.
· Get students to justify their thoughts and explain their reasoning to each other. You should not only ask for justifications from the ones who get it right, but also those who get it wrong.
· Use the wiggle test by grabbing a particular point and moving it a little bit to show what happens in the image (particularly useful for transformations).
· Use the software to follow the natural progressions that students follow. If looking at something in 2D, why not extend this to 3D. What would happen if a piece of data changed?
· When using the [image: Constant Controller] Constant Controller, start by using concrete numbers (eg , ) then change to the constant (). However, before clicking OK, go to "Edit Constants" and change the constant to the value it currently has (in this case 2). When you then click OK, nothing will change, and you can ask for predictions when you change the constant.
· Make use of the [image: Slow Plot]Slow Plot and [image: Scribble]Scribble functions on Autograph.
· Give students a chance to change their mind. This allows them to feel like they are in a safe environment, where they can make mistakes, but learn from them. It is so important that students feel safe, and allowing them to correct themselves will give them confidence to try.
	




	[bookmark: _Toc375131622]SHAPE
	Resources

	[bookmark: _Toc375131623]Transformations
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that the  values go from -10 to 10. Uncheck the Auto box for the pips and set this to 1 for both  and . Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected.
· Draw a rectangle by [image: mode-point 24 h p] Adding Points as the vertices, and [image: Cursor] Selecting them all and right clicking to “Group to Shape”. We are going to reflect the rectangle, what do we need? We shall reflect in , what does this look like (use Scribble [image: Pencil 24 h p]to predict). Use [image: plot-slow 24 h p]Slow Plot to check by [image: add-equa 24 h p] Entering the Equation. Where will the shape end up (use Scribble [image: Pencil 24 h p]to predict)? [image: Cursor] Select the rectangle and the line, right click and choose “Reflection”. Which corner will move (wiggle test)?
· Now we are going to rotate the new shape. What do we need? Where will it end up (use Scribble [image: Pencil 24 h p]to predict)?  [image: mode-point 24 h p] Add a Point as a centre of rotation, and [image: Cursor] select this and the new rectangle, right click and choose “Rotation”. If you want a clockwise rotation of 90°, remember to make it -90° in the box. Wiggle test.
· Now we are going to translate the new shape. What do we need? Where will it be (use Scribble [image: Pencil 24 h p]to predict)? [image: mode-point 24 h p] Add a Point, [image: Cursor] select it, right click and choose “Vector”. Enter the vector for the translation. Now [image: Cursor] select the vector and new rectangle, right click and choose “Translation”.
· Now we are going to enlarge the new shape. What do we need? Where will it be (use Scribble [image: Pencil 24 h p]to predict)? [image: mode-point 24 h p] Add a Point as the centre of enlargement, [image: Cursor] select it and the new rectangle, right click and choose “Enlargement”. Give a scale factor of 2.
· Challenge: where will the final shape go if we move the original 1 square right? (2 squares down)
· For each of the transformations, the real power is in the dynamic nature of the software:
1. For reflection, instead of entering the equation of a line [image: mode-point 24 h p] Add a Point, and select it a right click and choose either “Vertical Line” or “Horizontal Line”. By [image: Cursor] Selecting the point, you can now move the line around to change a reflection (remember to get them to predict first). 
2. Similarly, for rotations and enlargements you can [image: Cursor] Select the centre and move it. You can also select the image and [image: animate 24 h p] Animate it, which adjusts the angle of rotation or the scale factor of enlargement. Again, you can ask “what will happen if…?” 
3. For a translation, you need to [image: mode-point 24 h p] Add 2 Points, and select them both, right click and choose “Create Vector”. Now when you use this vector, you can adjust the vector by grabbing either of the end points.
· Extension: transformations in the 3D plane (discussion of what information is needed, what will happen); matrix transformations.
	· Autograph Activity with demonstration video
· Axes
· Rectangle
· Line
· Reflection
· Point
· Rotation
· Vector
· Translation
· Point
· Enlargement
· Help videos for transformations
· Transformation Online Activities
· 3D Transformations
· Matrix Transformations
· Transformations Man
· Transformations Golf
· Leap Frog

	[bookmark: _Toc375131624]Angles
· Guess/Make the angle is an excellent starter. How does this help us with answering questions? We can see if our drawn angle makes sense (does it look right?)
· Dynamic Nature of Autograph means we can create angles and investigate the angle facts. Open a [image: page-new 2d 24 h p] New 2D Graph Page, and under [image: axes-edit 24 h p] Edit Axes go to “Options” tab and change Axes, Grid and Key to “None”. Select [image: axes-snap10 24 h p] Grid Snap Settings of 0.1.
· [image: mode-point 24 h p] Add two Points, [image: page-new 2d 24 h p] Select them both and right click. Choose “Line Segment”. Repeat so that the two line segments intersect. [image: page-new 2d 24 h p] Select both line segments, right click and “Solve Intersection”. [image: mode-point 24 h p] Add a Point to this intersection. [image: page-new 2d 24 h p] Select three points to form an angle, right click and select “Angle…”. Click OK in the dialogue box that appears to show the angle.
· To create parallel lines [image: mode-point 24 h p] place two points, right click and add “Straight Line”. [image: mode-point 24 h p] Add a third point (and colour this red to make it stand out). Now [image: page-new 2d 24 h p] Select the red point and the line, right click and select “Parallel Line”. You can now add a line segment that intersects both lines, and find the angles as above.
	· Guess/Make the Angle
· Angle Facts Collective Memory
· Angle Facts (AGG)
· Stickman Angles
· Striping Angles
· Bearings Murder Mystery (PDF)
· Bearings Murder Mystery (AGG)
· Measuring Angles Video

	[bookmark: _Toc375131625]The Stubborn Square
· We can easily make a square in Autograph. The problem is, if you move a corner, it is no longer a square.
· Challenge: Make a square that no matter what you do to it, it remains a square. There are two options here: it always remains a congruent square; it can become an enlargement.
· Extension: Try an equilateral triangle; regular hexagon; rectangle.
· Super Challenge: Can you make a full set of “Indestructible Quadrilaterals”.
	· Full instructions
· Make Quadrilaterals
· Make Quadrilaterals Online Activity

	[bookmark: _Toc375131626]Pythagoras and Trigonometry
· We can use Autograph to construct a right angled triangle. We can then use it to find the different lengths of sides or angles in triangles. Start by choosing [image: axes-edit 24 h p] Edit Axes, and under the “Options” tab select None for both Axes and Key. [image: mode-point 24 h p] Add two Points as the base of the triangle. [image: Cursor] Select both points, right click, and choose “Line Segment”. Now [image: Cursor] Select this segment, and one point, right click and choose “Perpendicular Line”. [image: mode-point 24 h p] Add a Point to this new line, then [image: Cursor] Select the line, right click and choose “Hide Object”. Now add “Line Segments” to form the triangle. [image: Cursor] Select the lengths you want to reveal, and add a [image: textbox 24 h p] Text Box… which will be dynamic.
· A trick to hide the answers is to put them in a text box with white writing to match the background. Also place a grey box big enough to cover the answer box. When you move the grey box over the answer, the white writing will show on the now grey background.
	· Pythagoras Questions
· Trig Angles
· Trig Sides

	[bookmark: _Toc375131627]Circle Theorems
· Due to the dynamic nature of Autograph, students can explore the properties of angles in circles individually or in pairs. This could be done using the online activities which are already set up for them to explore, or using the set of worksheets which get students to create their own Autograph documents and then explore. This is great for getting them used to using Autograph, and exploring the buttons and how the software works.
· Whichever way you go, it is important that students keep a record of their findings, and they do this in the Record of Observations sheet.
	· Circle Theorem Online Activities
· Angle at Centre
· Angle in Semicircle
· Cyclic Quadrilateral
· Angles in Same Segment
· Tangents
· Alternate Segment Theorem
· Intersecting Tangents
· Record of Observations
· Tick or Trash
· Multiple Choice Plenary
· Collective Memory

	[bookmark: _Toc375131628]3D
· The Autograph 3D Environment is excellent, and can be really helpful for students, especially those who struggle to visualise things in 3D.
· What would be the coordinates of the vertices of a  cube centred on ? This is a nice introduction to 3D coordinates, and in essence is a combinations problem (each of the three coordinates can take two values). Once students have decided on the coordinates, we can start using Autograph.
· Open up a [image: page-new 3d 24 h p] New 3D Graph Page, and [image: axes-edit 24 h p] Edit Axes so that ,  and  all go from -2 to 2. Under “Options” tab, uncheck Always Outside and Show Bounding Box. Now [image: add-coords 24 h p] Enter Coordinates, and do so systematically to ensure you have all the vertices of the cube. Now [image: Cursor] Select two of the points, right click and choose “Line Segment”. Repeat this for each pair of points until you have a complete cube. You can [image: Cursor]Drag the page around simply by clicking on the background and dragging the mouse to get a better view and make sure you do not miss any edges. With all the edges in place, to make it a little neater, press CTRL-A (select all) and change the [image: line-col 24 h p] Line Colour so that the whole cube is the same colour. At any point, press [image: 3d-restoreorien 24 h p] Restore x-y-z Orientation to go back to the standard view of the axes.
· Now we can use our cube to look at various things in 3D. How many vertices, edges and faces are there? Is there a link? Does this work for other 3D shapes?
· With the cube made, challenge students to make other 3D shapes using Autograph.
· We can also use it to explore 3D Pythagoras and Trigonometry. First we are going to remove the axes by going to [image: axes-edit 24 h p] Edit Axes, the “Options” tab, and under Axes select “None”. Now [image: Cursor] Select two vertices which are diagonally opposite each other, right click and choose “Line Segment”. How long is this diagonal? Where is there a right angled triangle? Add a “Line Segment” between two vertices that generate a right angled triangle. How long is this line? When students have had a chance to work it out, [image: Cursor] Select the line segment and the distance appears in the Status Box at the bottom of the screen (double click on it to make it larger). It is given as a decimal, but can be easily checked if it is the same as the surd answer.
· We can also find the angles between these two diagonals. [image: Cursor] Select the lines you want to find the angle between, right click and choose “Angle between Lines”. The answer will appear in the Results Box (which will automatically open if not already).
· Again, this is not limited to the cube, you can make many different 3D shapes using Autograph, and challenge students to find the lengths of diagonals. Or, better yet, get them to design their own 3D shape and to work out the diagonal, and then set the question to their peers.
	· Autograph in 3D Video
· Constructing Cubes Video
· 3D Pythagoras and Trigonometry Video
· Pythagoras in 3D online Activity
· Axes
· Cube points
· Cube complete
· Cube diagonal
· Cube hint
· Cuboid points
· Cuboid complete
· Cuboid diagonal
· Cuboid hint
· Pyramid points
· Pyramid complete
· Pyramid diagonal
· Pyramid hint
· Prism points
· Prism complete
· Prism diagonal
· Prism hint

	[bookmark: _Toc375131629]Planes of Symmetry
· How many planes of symmetry does a cube have? What would be the equations of the planes of symmetry?
· Ask students how many planes they think there are, and get each student to justify their answers. Discuss any duplications or missed planes.
· What are the equations of the planes of symmetry? Ask students to identify where a plane is, before attempting to name it. Discuss why the three “flat” planes are called , , . What might the other “sloped” planes be called? If this one is , what might the others be? (, , , , )
· This discussion can be extended to cuboids of different shapes and sizes.
	· Planes of Symmetry Starter (PPT)
· Planes of Symmetry Activity - Cube (AGG)
· Planes of Symmetry Activity – Cuboid 1 (AGG)
· Planes of Symmetry Activity – Cuboid 2 (AGG)
· Planes of Symmetry Video




	[bookmark: _Toc375131630]DATA AND STATISTICS
	Resources

	[bookmark: _Toc375131631]Relevant Data
· To engage students in data topics, they need to see the relevance in the data, or have a vested interest in the data.
· A simple way to collect data from the class is to use How Many Dots. This involves showing a class a screen with lots of dots on it for 2-3 seconds, and then getting each student to estimate the number of dots they saw. Have them write their answers down and tell them not to change their estimate on what others say (get them to show you on Mini-Whiteboards all at the same time).
· You now have a set of data which the students have created themselves! You can collect this data in Excel, and get students to calculate the Mean, Median, Mode and Range before using Excel to work these out. Then give the class a second chance to make an estimate. They can change or stay the same, it is their choice. You can now compare the two sets of data as well! Ask them how they think the Mean, Median, Mode and Range will change with the new set of data.
· By this point, the class will be desperate to know the actual number of dots. But don’t tell them until you have managed to get everything you can out of this simple set of data. We can now create and look at various statistical diagrams using Autograph: Box and Whisker Plots; Cumulative Frequency; Histograms; etc (See below for how to use each of these!)
· There are lots of other great ways to get students to collect their own data. Classic games like estimate the number of sweets in a jar are similar in style to the How Many Dots game. There are also lots of other games available which provide scores. Why not set a homework where students must play a game, and record their best score? Or best three scores to get even more data great for grouping! You could get them to submit these results via a Google Form so you have all the data ready for the next lesson.
	· How Many Dots – original
· How Many Dots – comparison
· How Many Dots Post
· Collecting the Data
· Games
· Escapa!
· Paper Aeroplane

	[bookmark: _Toc375131632]Raw Data – Box and Whisker Plots
· With your data collected in Excel (or similar spreadsheet) it is easy to transfer it to Autograph. Select one set of data from the spreadsheet (including the title if there is one). Press Ctrl-C to copy this data.
· Open up a [image: page-new 1d 24 h p] new Statistics page in Autograph in Standard Level. Now [image: stats-add-rawdata 24 h p] Enter Raw Data… and in the Data section paste (Ctrl-V) the data. You can rename the data set at the top of the dialogue box as well. Now click OK.
· Now our data is saved, we create the chart by selecting [image: stats-boxwhsk 24 n p] Box and Whisker Diagram, and select Raw Data. With this diagram created, what does it tell us? What would happen if we removed any outliers from the data?
· What will the second set of data look like when presented like this? Get students up to [image: Scribble] Scribble what they think it will look like. [image: stats-add-rawdata 24 h p] Add this data in the same way, and create a second [image: stats-boxwhsk 24 n p] Box and Whisker Diagram.
· What do these two diagrams tell us about the two sets of data we have? Is the second guess better or worse?
	· Working with Raw Data Video 1
· Working with Raw Data Video 2
· How Many Dots Example Box and Whisker

	[bookmark: _Toc375131633]Grouped Data – Histograms, Stem and Leaf Diagrams, Cumulative Frequency
· If we have a lot of data, we might want to convert this to a Frequency Table, so we can use other charts. Autograph can convert raw data into Grouped Data really simply. Once again, select your raw data in Excel and copy it.
· Open up a [image: page-new 1d 24 h p] new Statistics page in Autograph in Standard Level. We want to [image: stats-add-grdata 24 h p] Enter Grouped Data… This opens up a rather complex looking dialogue box. We want to use our raw data, so we select “Use Raw Data” in the Frequencies section, and click the “Edit” button that unlocks. Paste the Raw Data into the dialogue box. You can use the Column Header section and also Sort by x to sort the data, but it is not necessary. Click OK to return to the Grouped Data box. Click OK again to save the data.
· There are now several things we can do with our grouped data.
· We can make a Frequency Diagram or [image: stats-histogram 24 h p] Histogram. With this choice we can use the frequency or the frequency density, and choose if we want to include a Frequency Polygon as well. One fantastic feature of Autograph is that we can now [image: animate 24 h p] Animate to dynamically change the group widths (though they will still all be the same, we shall see how to make different widths later).
· Autograph can also do lots of calculations on our data that we have input. The [image: stats-box 24 h p] View Statistics Box shows all the useful statistics about our set of data, both the Raw Data and the Grouped Data. This is an excellent way to compare the mean and other statistics between the two types of data. The [image: stats-table 24 h p] Table of Statistics opens up the Results Box, and generates a full frequency table, with midpoints, class widths, and cumulative frequencies. The [image: stats-stemleaf 24 h p] Stem and Leaf Diagram generates a stem and leaf diagram in the Results Box. The best thing about these last two is that they are simply text, so can be easily selected and copied and pasted into a Word Document.
· We can also make a [image: stats-cumfreq 24 h p] Cumulative Frequency Graph with our grouped data. The options here are simple, and usually the default ones will more than suffice, so just click OK. There is much more on this below.
	· Changing Raw Data to Grouped Video
· Grouped Data Video
· How Many Dots Example Histogram 1
· How Many Dots Example Histogram 2
· How Many Dots Example Results Box
· How Many Dots Example Cumulative Frequency

	
	

	[bookmark: _Toc375131634]Cumulative Frequency Collective Memory
· A collective memory is an activity which involves groups recreating a poster on a particular topic. It requires students to use their memory and common sense. There are several ways to run a Collective Memory: one person comes to the front from each group and looks at the poster, before describing to the rest; all get to look at it for 20 seconds on the board (during which they cannot write or talk).
· Once the activity is over, it is really important to discuss any teaching points before you reveal what the original poster looked like (they will be desperate to see, and focus is lost after you show them). Points to discuss include general things related to the activity (what methods did you use, what was easiest/hardest) and topic specific questions (how are the tables related, how many guests).
· A great way to use these posters for the students is to print them off one each as well. That way they can annotate their notes onto the poster for reference to later.
· The real beauty of this Collective Memory is that as the graph is made in Autograph, we can open up the original file. Now we can start to investigate some properties of the graph.
· How could we find the Median age of guest? Get students to come up to the board and use Scribble [image: Pencil 24 h p]to predict the answer. Now use [image: stats-cumfreqm 24 h p] C.F.D Measure and select Median in the pop-up box. Two bars now appear, and the horizontal one is in the right place for the median (why is this the right place?) By grabbing the little yellow diamond at the bottom of the vertical bar you can move the bar so it reads of the Median value (why is the median not just 40?) This process can be repeated for the Quartiles and Inter-Quartile Range. You can then check all these in the [image: stats-box 24 h p] Statistics Box. For a higher ability set, you may not want to give them the position up the axis of the median. To stop this, just select User Defined and then you can move both bars freely.
· Another nice extension question to ask here: what would happen to the graph if 20 more 85 year olds turned up to the wedding? What about if 20 more 15 year olds turned up? Get students up to the boards to use Scribble [image: Pencil 24 h p]to predict how the graph will change. Now we can use Autograph to edit the data easily. Right click on the page and choose Edit Data Set… which opens up the Grouped Data dialogue box. In the frequencies section at the bottom we have the different frequencies entered manually, so we can change the 5 (which is the 80-100 group) to 25, and click OK. Voila, the graph has changed.
	· Activity Notes
· Collective Memory
· Poster to Print
· Autograph File
· Downloadable Collective Memories
· Inputting Grouped Data Video

	





	

	[bookmark: _Toc375131635]Labelling Statistical Diagrams
· Autograph is excellent at drawing statistical diagrams, but it can also be used very successfully to identify the key parts of the diagrams.
· After generating a nice plot from some relevant data, add some generic [image: textbox 24 h p] textboxes with important labels such as “minimum value”, “median”, “lower quartile”, etc.
· With these on the chart, get students to position them in the correct places. Some of them might be a matter of knowledge (locating the median on a box and whisker diagram) and others may require calculations (finding an estimate of the mean from a cumulative frequency graph). If calculating statistics, then don’t forget to check them using the [image: stats-box 24 h p] Statistics Box.
	· Label the Box and Whisker Diagram
· Label the Cumulative Frequency Diagram
· Label the Histogram

	[bookmark: _Toc375131636]Probability Distributions
· You can use the inbuilt probability distributions in Autograph to generate a variety of data that could be generated by particular experiments. We shall look at several of these.
· To create a set of data that represents a fair dice, [image: stats-add-rawdata 24 h p] Enter Raw Data… and “Select Distrib.”. Choose User (discrete) as this allows us to enter our own probabilities. Now click on “Edit Distrib.” And you will be presented with the parameters box. For this distribution, you set the probability for each value 0, 1, 2, 3, etc. So for our fair dice example we want to enter 0,1/6,1/6,1/6,1/6,1/6,1/6 into the box (we need the initial 0 as the probability of getting 0 is 0). Now press OK, and click “Create Sample”. This generates a random set of data for the distribution we have chosen. We can quickly plot this by pressing OK to close the dialog box, and selecting [image: stats-dotplot 24 h p] Dot Plot. Make sure the two spacing settings are 1, and hit OK. This produces a very visual interpretation of the data. You can then ask students if they think the dice is fair (in the example file, they might suggest that 1 and 4 are biased). By double clicking on the Raw Data 1, you can quickly create a bigger sample. In the dialog box, change “Sample Size,N:” from 100 to 10000, and “Create Sample”. Once you hit OK, you will need to [image: axes-default 24 h p] Autoscale. This should produce a much clearer picture of the fairness of the dice, and leads to a nice discussion of sample size.
· To create a new set of data for a biased dice, open a [image: page-new 1d 24 h p] New 1D Statistics Page, and [image: stats-add-rawdata 24 h p] Enter Raw Data… Once again choose the User defined distribution, but this time, enter non-equal probabilities, such as 0,1/12,1/6,1/6,1/6,1/6,3/12 (make sure they add to 1). Generate a sample of size 10000, and click OK. You can either do this live in front of the class, and get them to predict what the new [image: stats-dotplot 24 h p] Dot Plot will look like, or show them one you created before the lesson, and get them to decide what the probabilities might be for each outcome.
· This is not limited to rolling of dice, it can be used for any probability distribution, such as drawing balls out of a bag. Show students a premade version, and challenge them to decide how many of each type are in the bag. For example, set the User distribution to 0,2/10,3/10,5/10 to represent a bag with 10 balls in, two of which are labelled 1, three are labelled 2 and five are labelled 3. Generate the [image: stats-dotplot 24 h p] Dot Plot, and tell students there are 10 balls, and you picked one ball at a time 100 times. This is a great introduction to Experimental Probability.
· We can also use other Probability Distributions. Open a [image: page-new 1d 24 h p] New 1D Statistics Page, and [image: stats-add-rawdata 24 h p] Enter Raw Data… This time, when you “Select Distrib.” choose Binomial, and “Edit Distrib.” to have the number of trials as 10, and the probability of success as 0.5. Explain to students that this is recording how often you get a head if you toss the coin 10 times. Click OK, and change the “Sample Size, N:” to 10, and “Create Sample”. Get students to predict what they think the box plot will look like, and then draw a [image: stats-dotplot 24 h p] Dot Plot. From this you can get students to work out what the [image: stats-boxwhsk 24 n p] Box and Whisker Diagram would look like. Now you can change the Sample Size to 100, and play around with the probability of success and get students to predict what will happen.
· The final distribution we shall look at is the Normal Distribution, in the context of IQ scores. Open a [image: page-new 1d 24 h p] New 1D Statistics Page, and [image: stats-add-rawdata 24 h p] Enter Raw Data… This time, when you “Select Distrib.” choose Normal, and “Edit Distrib.” to have  as 100 and  as 15 (the mean and standard deviation used for the IQ test). Click OK and create a samplof size 1000. We get some nasty data, but Autograph can fix that for us. In the “Scale Options” box enter int(x) and hit “Scale-x” to convert each piece of data to its integer value. Now we can look at the [image: stats-dotplot 24 h p] Dot Plot, which will demonstrate the clear bell shaped curve.
	· Probability Distribution Online Activities
· Fair Dice Simulation 100 file
· Fair Dice Simulation 10000 file
· Biased Dice Simulation file
· Balls in a Bag 100 file
· Dice Simulation video
· Fair Coin Simulation 10 file
· Fair Coin Simulation 100 file
· Biased Coin Simulation 100 file
· Binomial Distribution video
· IQ Simulation 1000
· Normal Distribution video

	

	




	[bookmark: _Toc375131637]ALGEBRA
	Resources

	[bookmark: _Plotting_Graphs][bookmark: _Toc375131638]Plotting Graphs
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that the  values go from -6 to 6. Uncheck the Auto box for the pips and set this to 1 for both  and . Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected.
· The most important aspect when looking at graphs is to make sure [image: plot-slow 24 h p] Slow Plot is also enabled.
· Write several equations of straight lines up on the board (enough to split the class into groups of 3 or 4 to work on each equation), and assign one equation to each group. Ideally this is on a separate board to the projected Autograph page.
· You will need coloured items for each equation (sticky notes, coloured board pens, coloured counters with a bit of blu-tac on one side), preferably a unique colour for each equation. Give the corresponding colour to the group working on that equation. As a group they need to put their sticky items on the board to show the line that they have been given. Allow groups to come up as they are ready to place their points.
· With all the groups having placed their points, go through them one at a time, by Entering an Equation (press Enter on the keyboard), and typing the equation. As soon as you click OK, it will start to slowly draw the line. As soon as the line appears on the page, press [image: plot-pause 24 h p] Pause to stop the animation. Allow the group to decide if they would like to change any of their points, and press [image: plot-pause 24 h p] Pause again to continue the animation.
· Instead of giving them a graph each to start with, you could tell them to consider all graphs for 5 to 10 minutes first, and only give them their coloured sticky items after this period.
· This activity works equally well with plotting lines using a table, plotting curves using a table or drawing graphs using .
· An alternative approach is to start with a spreadsheet containing two columns each headed with an equation, and the left most column with a series of values for . On the board, in each space place a coloured sticky note or counter with blu-tac attached. There should be one of these for each student in the room (at least). Get the class to come take a counter and place it in the correct place on a set of axes that you have set up.
· Once all the counters have been placed on the Autograph axes, make sure [image: plot-slow 24 h p] Slow Plot is enabled, and Enter the equation. Remember to [image: plot-pause 24 h p] Pause the animation and allow students to change their minds.
	· Blog Post
· Plotting Graphs Online Activity
· Blank Axes
· Plotting Quadratics Excel File

	



	

	[bookmark: _Toc375131639]Investigating  
· You can easily investigate the equation of a straight line using Autograph. First open a [image: page-new 2d 24 h p] New 2D Graph Page, and [image: axes-edit 24 h p] Edit Axes so that the  axis goes from -6 to 6. Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected.
· Start by asking students what some lines look like (for example , ) and get them to use the [image: Pencil 24 h p] Scribble pen to draw them. Enable [image: plot-slow 24 h p] Slow Plot, and Enter the equations. Ask if they notice any relationships between the lines and their equations. To show the equation with the line, select the line and click [image: textbox 24 h p] Text Box (you can change the appearance if you want, but don’t need to). To change the line double click on it, and change the equation.
· After looking at a few of these, double click the line to change the equation, and enter . Before clicking OK, we are going to change the constants to match the last graph drawn. For example, if the last equation was , we click on “Edit Constants” and give “” the value  and “” the value. This way nothing changes and we can talk the students through the more algebraic expression.
· We can now use the [image: constantcon 24 h p] Constant Controller to change the values of  and . Under “Options” you can plot a range of lines with different values, or even set up an animation.
· To explore the gradient of the line, [image: mode-point 24 h p] Add two Points on the line. [image: Cursor] Select the two points, right click and choose “Gradient” to form a gradient triangle. [image: Cursor] Select this triangle and press [image: textbox 24 h p] Text Box to get the value of the gradient. This is also something to discuss (where do the different bits come from). This can be a whole activity in its own right before even looking at the equations of straight lines, particularly focussing on why it doesn’t matter which two points you pick to measure the gradient (move the points along the line and the gradient stays the same).
	·  Activity
·  with constants
· Gradient Activity

	[bookmark: _Toc375131640]Parallel and Perpendicular Lines
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that the  values go from -6 to 6. Uncheck the Auto box for the pips and set this to 1 for both  and . Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected.
· Instead of entering the equation of a line, [image: mode-point 24 h p] Add two Points on the grid. [image: Cursor] Select them both, right click and choose “Straight Line”. Now [image: Cursor] Select each point individually, right click and choose “Circle (Radius)” and give the circle a radius of about 0.1.
· By grabbing these points you can easily change the line, and for each one ask the students to give the equation of the line (recapping ). To reveal the equation, select the line and the equation will appear in the Status Box at the bottom of the screen (you can double click this to make it larger). Alternatively, with the line selected, insert a  [image: textbox 24 h p] Text Box.
· Now [image: mode-point 24 h p] Add a Point somewhere not on the line. [image: Cursor] Select the line and the new point, right click and choose “Parallel Line”. What is the equation of this new line? Add a circle around the point on this line. What happens when you move this point? What happens when you change the original line by moving the two original points? What are the similarities and differences between the two lines (and their equations)?
· [image: Cursor] Select the parallel (second) line, and delete it. Now [image: Cursor] Select the original line and the point that was on the parallel line, right click and choose “Perpendicular Line”. How are these 2 lines related? What happens when you move each of the points? 
· By removing the [image: axes-equalaspect 24 h p] Equal Aspects, we can now get some interesting results, for example showing that the two objects are squares in the resources.
	· Starting Line
· Parallel Lines
· Perpendicular Lines
· Square (easy)
· Square (harder)

	[bookmark: _Toc375131641]Coordinate Battleships
· Once students have encountered the equation of a straight line, this is a lovely activity for practicing using it.
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that the  values go from -6 to 6. Uncheck the Auto box for the pips and numbers and set this to 1 for both  and . Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected.
· We are going to start by placing boats on the grid. To do this make sure [image: axes-snap1 24 h p] Grid Snap Ones is selected, and [image: mode-point 24 h p] Add a Point anywhere on the grid. To highlight this point, [image: Cursor] Select it, right click and choose “Circle (Radius)” giving it a radius of 0.2.
· We are also going to give this ship a label. Again [image: Cursor] Select the point (not the circle), and click [image: textbox 24 h p] Text Box. Deselect “Show Detailed Object Text”, and press the “Remove Object Text” button. Now select all the remaining text and replace it with A. Use the “Edit Font” and “Edit Frame” options to get it looking how you want.
· Now repeat this many times to produce a grid with plenty of ships on it (like in Grids 1-3 in the resources).
· With the board set, split the class into groups. Taking it in turns, each group gives the equation of a line. When they do, they must say which ships they think it will pass through. Once done, ensure [image: plot-slow 24 h p] Slow Plot is enabled, and Enter the equation they gave. The points they get are the number of ships they pass through with their missile (as long as the ship has not already been hit by another missile previously).
· You can add levels of complexity by setting rules like: diagonal lines score double points; negative gradients score triple points; etc.
· After the game is done, you still have plenty of questions to ask. Which line would hit the most ships? What is the fewest number of missiles needed to sink all the ships? Can you make a starting layout that requires the most number of missiles to sink all the ships?
	·  Activity
· Coordinate Battleships Video
· Battleships 1
· Battleships 2
· Battleships 3
· Grid 1
· Grid 2
· Grid 3

	[bookmark: _Toc375131642]Investigating Parabolas
· Parabolas appear in lots of different areas, and are a great way to incorporate some images into Autograph. Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that the  values go from -2 to 6. Uncheck the Auto box for the pips and set this to 1 for both  and . Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected.
· Now we are going to get an image to put into the page. Go the TSM Parabolic Images folder, and go to HumanCannonBall and open the photo (or open it directly using resources link). Either drag and drop this photo into the Autograph page, or right click to Copy and right click in the Autograph page to Paste Image.
· We can adjust the image by dragging it, resizing it and best of all, adjusting the transparency. First of all, double click on the image, and change the transparency to about 50%. You should now be able to see the axes beneath the image. Drag it so the start point is on the  axis, and resize it so it is a good size to see.
· Now we are going to fit a parabola to the curve. There are many ways to do this, but discuss the options with the class. As it is a parabola, the equation must be a quadratic, and as it has a maximum it must be a negative quadratic. Some of the possible equations you could enter are: ; ; . Although the class might not come up with these themselves, you can certainly discuss where each of them comes from.
· Now allow students to use the [image: constantcon 24 h p] Constant Controller to adjust the values of the constants to come up with a parabola that fits the path of the Human Cannonball.
· This is best done if students have access to the file themselves to play around with it (or if you have made it into an online Autograph Activity). After they have had a chance to get the parabola to match the flight path, discuss what effect each of the constants had on the parabola (stretching, crossing axis, etc).
· This activity is certainly not limited to this image, and there are plenty of other great examples (Angry Birds is a popular one).
	· TSM Parabolic Images
· Human Cannon Ball Photo
· Images in Autograph Video
· Human Cannonball 1 Image ready
· Human Cannonball 1 Student Ready
· Human Cannonball 1 Complete
· Human Cannonball 2 Image ready
· Human Cannonball 2 Student Ready
· Human Cannonball 2 Complete
· Human Cannonball 3 Student Ready
· Human Cannonball 3 Complete
· Batman Equation

	[bookmark: _Toc375131643]Inequalities
· Autograph is not only capable of dealing with equations, it can also work with inequalities. Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that the  values go from -6 to 6. Uncheck the Auto box for the pips and set this to 1 for both  and . Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected.
· What does  look like? Use the [image: Pencil 24 h p] Scribble pen to predict what it will look like. Ensure [image: plot-slow 24 h p] Slow Plot is enabled. Press Enter to open the [image: add-equa 24 h p] Enter Equation box and type . What would be different if it was ? Double click on the line and change it to this (using the symbols below the equation box or typing “<=”). Which bit is shaded in? Why?
· What does  look like? Use the [image: Pencil 24 h p] Scribble pen to predict what it will look like. Ensure [image: plot-slow 24 h p] Slow Plot is enabled. Press Enter to open the [image: add-equa 24 h p] Enter Equation box and type . What would be different if it was ? Double click on the line and change it to this (using the symbols below the equation box or typing “>=”). Which bit is shaded in? Why?
· What does  look like? Use the [image: Pencil 24 h p] Scribble pen to predict what it will look like. Ensure [image: plot-slow 24 h p] Slow Plot is enabled. Press Enter to open the [image: add-equa 24 h p] Enter Equation box and type . What would be different if it was ? Double click on the line and change it to this (using the symbols below the equation box or typing “<=”). Which bit is shaded in? Why?
· This can then all be combined to look at multiple inequalities to define a region. Such as: ; . Always get students to predict first.
	· Complex Regions




	[bookmark: _Toc375131644]NUMBER
	Resources

	[bookmark: _Toc375131645]Number Lines
· Open a [image: page-new 2d 24 h p] New 2D Graph Page and open [image: axes-edit 24 h p] Edit Axes. Change the minimum value of  to 0, and the maximum value to 10. Deselect the Auto checks for both “Numbers” and “Pips”, setting “Numbers” to 1 and “Pips” to 0.2. Now select the Options Tab, and under “Axes” choose Hide , and under Grid select None. Finally, under Key, choose None. Click OK and you get a simple number line.
· Now we can add a marker to this number line to indicate the value we want. [image: mode-point 24 h p] Add a Point above the axis, [image: Cursor] Select it and right click. Choose “Vertical Line”. You can now move this line by dragging the point (or [image: Cursor] Selecting it and using the keyboard arrows to move it) and ask students to write down the value on Mini-Whiteboards.
· You can make the point more clear by [image: Cursor] Selecting it, right clicking and choosing “Circle (Radius)”. Choose a radius of about 0.1, which will just highlight the point.
· You can follow the same method, but choose different Number and Pip values to get different number lines, and you can go into negative numbers as well by changing the  values (if it doesn’t go wide enough, deselect [image: axes-equalaspect 24 h p] Equal Aspect, but this will make the circle go a bit funny!).
	· Number Line 1
· Number Line 2
· Number Line 3
· Number Line 4
· Number Line 5

	[bookmark: _Toc375131646]Plotting Root 2 and Irrational Numbers
· A nice little challenge using a bit of constructions and Pythagoras’ Theorem is to plot the exact point of .
· We start by getting a number line. Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that the  values go from -1.5 to 2. Uncheck the Auto box for the pips and numbers and set this to 1 for both  and . Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected. Now select the Options Tab, and under “Axes” choose Hide , and under Key, choose None. Click OK. You might need to [image: Drag] Drag the screen so you can see the value . [image: add-equa 24 h p] Enter the Equation .
· [image: add-coords 24 h p] Enter coordinates at  and . Construct the Perpendicular Bisector of these two points by [image: Cursor] selecting each individually, right clicking and choosing “Circle (Radius)” and giving them both a radius of 1.5. Now [image: Cursor] Select both these circles, right click and choose “Solve Intersection”. [image: mode-point 24 h p] Add a point to both these intersection points, [image: Cursor] Select them both, right click and choose “Straight Line”. [image: Cursor] Select the two circles, right click and “Hide Objects”. (Alternatively you can [image: Cursor] Select the two original points, right click and choose “Perpendicular Bisector”, but this does not demonstrate how to do it by hand).
· Now we have a length that is exactly 1. [image: Cursor] Select the line across the axis and the perpendicular bisector, right click and “Solve Intersection”. [image: mode-point 24 h p] Add a Point to this intersection. [image: Cursor] Select the Origin and the point at 1 (in that order), right click and choose “Circle (2 pts)”. [image: Cursor] Select the circle and the perpendicular bisector and “Solve Intersection”. [image: mode-point 24 h p] Add a Point to the intersection point above the axis. [image: Cursor] Select the circle and “Hide Object”. [image: Cursor] Select the Origin and the new point, right click and choose “Line Segment”.
· Scribble the lengths of the sides of this triangle: Base = 1; Height = 1; Hypotenuse = .
· Finally we are going to make a circle centre the origin, and radius the hypotenuse. [image: Cursor] Select the highest point of the triangle and the origin (in that order), right click and choose “Circle (2 pts)”. Where this circle crosses the x axis is at exactly .
· You can now [image: mode-zoomboxi 24 h p] Zoom in to this point to see the decimals go on forever (well, they eventually stop, but the point is proven).
	· Number Line
· Perpendicular Bisector
· Perpendicular Bisector 2
· Triangle
· Triangle 2
· Markings
· Pythagoras
· Circle




	[bookmark: _Toc375131647]A-LEVEL
	Resources

	[bookmark: _Toc375131648]Investigating The Shapes Of Graphs
· Autograph is fantastic for students getting their heads round all the different shapes of graphs. This can be done in two ways: at the front of the class, ask the students what they think each graph will look like, and how the constants will affect it (make use of [image: Pencil 24 h p] Scribble and [image: plot-slow 24 h p] Slow Plot); let them use the software to explore and come up with ideas themselves to discuss at the end.
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: add-equa 24 h p] Enter the Equation . [image: Cursor] Select the curve and add a [image: textbox 24 h p] Text Box. Use the [image: constantcon 24 h p] Constant Controller to edit the constants  and .
· Repeat this process with the following equations:
1.  (with  to start with)
2.  (with  to start with)
3.  (with  to start with)
4.  (with  to start with)
5. (with  to start with)
6.  (with  to start with)
	· Quadratics (factorised)
· Quadratics
· Cubics
· Quartics
· Reciprocals
· Reciprocal Powers
· Roots

	[bookmark: _Toc375131649]Graph Transformations
· Autograph has an excellent function ability, that makes looking at graph transformations really easy. We are going to look at the function . To enter this in Autograph, on a [image: page-new 2d 24 h p] New 2D graph page, click [image: equ-funcdef 24 h p] Function Definitions. Replace the text with . When we press OK, nothing appears to happen, as this is just telling Autograph what the function is, we haven’t asked it to draw the graph yet. Now [image: add-equa 24 h p] Enter Equation, and type . When you press OK, the graph will appear.
· We are going to change the axes so we have room for movement. First deselect [image: axes-equalaspect 24 h p] Equal Aspect, and then [image: axes-edit 24 h p] Edit Axes. Set  from -5 to 5, and  from -10 to 10. Now [image: Cursor] Select the curve and press [image: textbox 24 h p] Text Box. Deselect “Show Detailed Object Text”, and press OK (you can change appearance of text box if needed).
· Now we set up the transformation. What will happen if we draw ? Get students to predict and use [image: Pencil 24 h p] Scribble to mark points. Then [image: add-equa 24 h p] Enter the Equation, making sure [image: plot-slow 24 h p] Slow Plot is enabled. Try some other numbers instead of 1, like . Now we shall generalise using the [image: constantcon 24 h p] Constant Controller. First, double click on the transformed graph, and change it to . Remember to “Edit Constants” so that nothing changes (in our case put ). Now open the [image: constantcon 24 h p] Constant Controller, and use it to change the value of , and note what happens.
· In a similar way, look at transformations of the form . Then put them together to have a combined transformation of the form . You can also look at what happens with  and  (remembering to get students to predict every time). In its most general form, you can consider the equation .
	· Transforming Graphs Student Worksheet
· Online Activities
· Transforming Graphs 1
· Transforming Graphs 2
· Transforming Graphs 3
· Transforming Graphs 4
· Transforming Graphs 5
· Transforming Graphs 6
· Video 1
· Video 2
· Video 3 – Follow the Point

	[bookmark: _Toc375131650]Differentiation
· Autograph is excellent at visually showing the gradient of a line, and using the same process, this can be extended to see the gradients of a curve, both by looking at the gradient of a chord and at the gradient of a tangent.
· Open up a [image: page-new 2d 24 h p] New 2D Graph Page, and [image: axes-edit 24 h p] Edit Axes so that the  values go from -6 to 6. Uncheck the Auto box for the pips and set this to 1 for both  and . Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected. Start by looking at a line, and [image: add-equa 24 h p] Enter the Equation . [image: mode-point 24 h p] Add two Points to the line, [image: Cursor] Select both points, right click and choose “Gradient”. Now [image: Cursor] Select each point in turn, add a [image: textbox 24 h p] Text Box, and do the same for the gradient triangle.
· You can discuss what is meant by  and , and see that even when you move the points up and down the line, the gradient stays the same. Try a [image: axes-snap10 24 h p] 0.1 Snapping as well.
· Now we can move on to look at curves. Open a [image: page-new 2d 24 h p] New 2D Graph Page and set it as before. This time [image: add-equa 24 h p] Enter the Equation  (you can get  quickly on Autograph by pressing ). Make sure you are in [image: axes-snap10 24 h p] 0.1 Snapping. [image: mode-point 24 h p] Add two Points to the line, [image: Cursor] Select both points, right click and choose “Gradient”. Rather than using a text box, double click on the Status Bar at the bottom of the screen to open up a larger version.
· By moving the two points around the curve, we can clearly see that the gradient is changing around the curve. This means we can discuss what it means to have a changing gradient.
· Now put the lower point at the coordinates  and the other point at . Discuss how this relates to the gradient of the curve (it is close, but not quite), and ask how we could get a better approximations. By moving the points closer together, we get a better approximation to the gradient of the curve at a particular point (this is Differentiating from First Principles). [image: mode-zoomboxi 24 h p] Zoom in to see a clearer picture as the approximation becomes better.
· We can extend this even further to look at tangents of curves and the gradient of these. Delete everything except the original curve, and [image: mode-point 24 h p] Add a Point to it, and with the point [image: Cursor] Selected, right click and choose “Tangent”. Ask students what this is, and how it relates to the curve. By moving the point, the tangent also changes. 
· Now [image: add-equa 24 h p] Enter the Equation , and similarly [image: mode-point 24 h p] Add a Point to it, and create the “Tangent”. We want to compare the tangents at the same  value, but rather than manually try to match them up, double click on each point, and set its  Co-ordinate to . Now we can use the [image: constantcon 24 h p] Constant Controller to adjust the value of  and see that the tangents are parallel, and so the gradients are equal at these points.
· Once again delete everything except the original graph. For this step we need to be in Advanced Mode. Go to View->Preferences… and to the “General” tab. Select Advanced Level and click OK.
· Ensure [image: plot-slow 24 h p] Slow Plot is enabled, and press [image: equ-gradient 24 h p] Gradient Function. When you press OK, Autograph will show the tangent as  increases, but also plot the gradient of the tangent at each point. It will stop at important points on the graph, and to continue the animation [image: plot-pause 24 h p] Continue. You should discuss what is happening (ask the students to explain first), especially at the points where it stops. You can then discuss the gradient function and how you get there.
· This method would work equally well for cubics, quartics and any other graph.
	· Gradient Tool Video
· Straight Line Gradient
· Curve Gradient Tool
· Gradient Function Video
· Parallel Tangents
· Gradient Function (quadratic)
· Gradient Function (cubic)

	[bookmark: _Integration][bookmark: _Toc375131651]Integration
· We can use Autograph to integrate functions as well as differentiate. In particular, it is excellent for finding areas under curves. Make sure you are in Advanced Mode for this section (View->Preferences->General).
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that  goes from -4 to 4 and  goes from -3 to 10. It is best to deselect [image: axes-equalaspect 24 h p] Equal Aspects for this. [image: add-equa 24 h p] Enter the Equation . Now [image: Cursor] Select the curve, right click and choose [image: findarea 24 h p] Find Area. A pop-up opens up with choices for method and parameters. Start by leaving “Rectangle (-)” selected, with Start point 0, End point 1 and 5 divisions. Use [image: mode-zoomboxi 24 h p] Zoom to get a better look. Is this a good approximation for the area? Is it an over or under estimate? How could we make this estimate better? To see the actual value of the estimate, select the rectangles, and it appears in the Status Box at the bottom (double click this to enlarge it).
· We can now easily play with the number of divisions by [image: Cursor] Selecting the Area and clicking [image: animate 24 h p] Animate. You can then see visually what happens as the number of divisions increases, and also see what happens to the area. Does it converge on a number?
· By double clicking on the area you can change the original method: Rectangle(+); Trapezium Rule; Simpsons Rule.
· We can also look at other types of area based questions.  Open up a [image: page-new 2d 24 h p] New 2D graph page. [image: add-equa 24 h p] Enter the Equation . Ask the students to find the area beneath the curve between  and . Now [image: Cursor] Select the curve, right click and choose [image: findarea 24 h p] Find Area. It does not matter which Method you choose (though Simpson’s Rule will give the closest approximation), and choose a large number of Divisions (around 200). The region will be highlighted and by adding a [image: textbox 24 h p] Text Box you see the area is virtually 0 (the same answer the students should have got). Now discuss that the area is clearly not 0.
· Delete the area, and [image: Cursor] Select the curve, right click and choose [image: findarea 24 h p] Find Area. This time, again choose whichever Method, and 200 divisions, but go from 0 to 1. Repeat this going from 1 to 3. Now two regions will be highlighted. For each one add a [image: textbox 24 h p] Text Box to see that the area below the curve is negative (and this is why they cancelled out). You can then discuss how to approach such problems, and why a sketch is so important.
· To find the area between a curve and the  axis, you must enter the equation with  as the subject. Open up a [image: page-new 2d 24 h p] New 2D graph page. [image: add-equa 24 h p] Enter the Equation . Now [image: Cursor] Select the curve, right click and choose [image: findarea 24 h p] Find Area. Choose the method you want, and suitable parameters (0 to 1 for range and any number of divisions). The area will appear in the right place automatically.
· Finally, we can find the area between two curves or between a curve and a line. Open up a [image: page-new 2d 24 h p] New 2D graph page. [image: add-equa 24 h p] Enter the Equations  and . To find the area bounded by both graphs, [image: Cursor] Select the line then the curve (order is important), right click and choose [image: findarea 24 h p] Find Area. Choose the options you want (high number of divisions is fine to show the area we want). Discuss how we would know which  values to use (finding the points of intersection) if it was not obvious.
	· Areas Under Curves Video
· Rectangle 1
· Rectangle 2
· Rectangle 3
· Trapezium Rule
· Tricky Integration Video
· Cancelled Areas
· Negative Area
· Area to  axis
· Area Between Line and Curve

	[bookmark: _Toc375131652]Volumes of Revolution
· As well as integrating in 2D, Autograph has excellent 3D capabilities, and can easily extend this into Volumes of Revolution. Open up a [image: page-new 3d 24 h p] New 3D Graph Page, and [image: axes-edit 24 h p] Edit Axes. Under “Options” tab, uncheck Always Outside and Show Bounding Box.
· Ask the students what  will look like in this 3D environment. Once they have discussed it, [image: add-equa 24 h p] Enter the Equation . This will give a parabolic plane. To move the axes round to get a better look, simply click on the background and drag the mouse. We however want a 2D representation of this graph, so double click on the plane and check “Plot as 2D equation (Cartesian Only)”. Now press [image: 3d-xy 24 h p] Restore x-y Orientation (which is under the arrow next to [image: 3d-restoreorien 24 h p] Restore x-y-z Orientation). You now have a parabola on a 2D axis. 
· [image: Cursor] Select the curve, [image: add-coords 24 h p] Enter Co-ordinates and give  the value 1. Repeat this with  value 2. [image: Cursor] Select both points, right click and choose [image: findarea 24 h p] Find Area. Choose the Method and parameters you want. Ensure [image: plot-slow 24 h p] Slow Plot is enabled. [image: Cursor] Select the area, right click and choose [image: volumeofrevolution 24 h p] Find Volume. We want to rotate about the  axis, so leave the axis of rotation as . Ask students what they think will happen. Click OK. Drag around the screen to get a good look.
· In much the same way as with the normal integration, we can look at various other Volumes of Revolution such as rotating about the y axis, or finding the volume bounded by a curve and a line. There are lots of nice activities and challenges to set on this idea: derive the formula for the volume of a cylinder, cone and sphere; can you make a shape that looks like a light shade; can you make a torus.
	· Introduction to Volumes of Revolution Video
· Axes
· Plane
· 2D Representation
· Points on Curve
· Area
· Volume
· Deriving the Formula Video
· Further Volumes of Revolution Video
· Rotating about y-axis
· Bounded Regions
· Cylinder
· Cone
· Sphere
· Making a Torus Video

	[bookmark: _Toc375131653]Calculus – Using Constants To Look at Limits
· When deriving various aspects of Calculus, we are looking at taking limits as a value gets smaller and smaller. This value is often called  or . We can make use of the excellent [image: constantcon 24 h p] Constant Controller to handle this and explore what happens.
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that  goes from -2 to 10. Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected. [image: add-equa 24 h p] Enter the Equation . Now [image: Cursor] Select the curve and [image: add-coords 24 h p] Enter Coordinates. As the point is on the curve, you only enter the value of , and  is automatically worked out. Give  a value of  (which will be 1 by default, but will allow us to change it easily). [image: Cursor] Select the curve and [image: add-coords 24 h p] Enter Coordinates this time making . [image: Cursor] Select each point individually and add a [image: textbox 24 h p] Text Box. Now [image: Cursor] Select both points, right click and choose “Gradient”, and give the resulting triangle a [image: textbox 24 h p] Text Box. Ask students what will happen as  is reduced. Use the [image: constantcon 24 h p] Constant Controller to adjust  and . You can also change the equation of the graph to explore other graphs.
· For Integration, the [image: findarea 24 h p] Find Area option is fantastic and you can use [image: animate 24 h p] Animate to change the number of divisions (see Integration).
· Open up a [image: page-new 3d 24 h p] New 3D Graph Page, and [image: axes-edit 24 h p] Edit Axes. Under “Options” tab, uncheck Always Outside and Show Bounding Box. [image: add-equa 24 h p] Enter the Equation  and check “Plot as 2D equation (Cartesian Only)”. Now press [image: 3d-xy 24 h p] Restore x-y Orientation (which is under the arrow next to [image: 3d-restoreorien 24 h p] Restore x-y-z Orientation). [image: Cursor] Select the curve, [image: add-coords 24 h p] Enter Co-ordinates and give  the value . Do the same giving  the value  (this is to see the overall area we are looking at), and again with value . [image: findarea 24 h p] Find Area between the first point and the second point, and the first and third points. Select the second (smaller) area, and [image: volumeofrevolution 24 h p] Find Volume. Now use the [image: constantcon 24 h p] Constant Controller to adjust . What shape is the volume approaching?
	· Differentiation
· Volumes of Revolution

	[bookmark: _Toc375131654]Exponentials
· Autograph can be used to discover the value  and the amazing property of the graph of . This is great if students have access to Autograph themselves.
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and [image: axes-edit 24 h p] Edit Axes so that  goes from -2 to 20. Make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected. Have [image: plot-slow 24 h p] Slow Plot enabled as well. [image: add-equa 24 h p] Enter the Equation  but before clicking OK, ask the students what they think this will look like. When they have come up with some ideas and used the [image: Pencil 24 h p] Scribble pen to jot down some points, reveal the graph. Now discuss with them what will happen if we change it to  (which points change, which points stay the same). Double click on the graph to change the equation and reveal (or [image: add-equa 24 h p] Enter new Equation to see them both).
· Now we are going to add a constant so we can easily change it. Revert the graph back to  first, and then change the equation to . Before clicking OK, “Edit Constants” so that . Now get students to use the [image: constantcon 24 h p] Constant Controller to investigate what happens as you change the value of . What if ? What if ?
· What does the gradient function of  look like? Get students to think about this, then (with  set to 2) [image: Cursor] Select the curve and use the [image: equ-gradient 24 h p] Gradient Function (you will need to be in Advanced Level). What will happen to the gradient function if we change  to 3? Use the [image: constantcon 24 h p] Constant Controller to change it. What has happened? The gradient function has gone from being less steep to more steep than the actual curve. So there must be a point where they are equal. Let students use the [image: constantcon 24 h p] Constant Controller to find this value. Explain that this is the special number .
	· Graph Investigation
· Gradient Investigation




	[bookmark: _Toc375131655]INVESTIGATIONS
	Resources

	[bookmark: _Toc375131656]Great Gonzo
· The Great Gonzo Game involves Gonzo being fired from a cannon through the air and landing in a tub of water. A bit of fun, but the scenario can be modelled rather well mathematically, and this model used to improve gameplay.
· Start by allowing the students to play the game a few times, to get to grips with how it works, and start to make some of their own ideas. This should take no longer than about 5 minutes.
· Once they have gotten their heads around the basic premise of the game, ask for some initial ideas they have had on succeeding the majority of the time. If they do not suggest it, lead them towards keeping one of the two variables (angle and power) constant, whilst changing the other. There are then fewer options to play with. Let them decide which they want to keep static (the model will be drastically different depending on which they choose. Keeping angle constant and changing power can lead to a linear relationship within the constraints of the game, whereas changing the angle but keeping the power the same will lead to a quadratic relationship)
· Discuss how there are no distance markers, but that there is a constant repeating background, which can be used as a unit (maybe 10 metres between the posts).
· Then get them to investigate and come up with their own model for the game. Can anyone get to a point where they are confident they will get Gonzo in the water every time?
	· Great Gonzo Game (online version)
· Student Worksheet
· Teacher Notes
· Answers (example)
· My Linear Results

	[bookmark: _Toc375131657]Pizza Problem
· This is an old problem which is all about cutting a pizza into pieces. The question is, for a given number of cuts, what is the maximum number of pieces (not slices) of pizza you can get?
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected. [image: add-coords 24 h p] Enter Coordinates at , [image: Cursor] Select this point, right click and choose “Circle (Radius)”. Give it a radius of 3. We do not need axes, so press [image: axes-none 24 h p] No Axes.
· Now [image: mode-point 24 h p] Add two Points on the circumference of the circle. Select them both, right click and choose “Line Segment”. Clearly, when there is only one slice, there are 2 pieces made.
· Now [image: mode-point 24 h p] Add two more Points on the circumference of the circle, and join these with a “Line Segment”. Now the maximum number of pieces is 4 (when the lines cross each other), but you can also get 3 pieces. [image: Cursor] Select one of the points and move it round to find the maximum number of pieces.
· Repeat this process, adding more and more slices, and each time counting the MAXIMUM number of pieces. It may become useful to use the [image: Pencil 24 h p] Scribble pen to mark each piece clearly. Press Edit->Select All Scribbles and then Delete to remove them all quickly.
· Students then investigate the relationship between the number of slices and the number of regions, and can try to formalise this as an algebraic expression.
	· Pizza Problem Video
· 1 Slice
· 2 Slices
· 3 Slices
· 4 Slices
· 5 Slices
· 6 Slices

	[bookmark: _Toc375131658]Circle Regions
· Quite similar to the Pizza Problem, in that it is all about splitting a circle into regions. This time though, we start with two points on the circumference and join them, to form 2 regions. Next we have 3 points on the circumference and join each point to every other point. Then 4 points all joint to each other, and so on, counting the number of regions.
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected. [image: add-coords 24 h p] Enter Coordinates at , [image: Cursor] Select this point, right click and choose “Circle (Radius)”. Give it a radius of 3. We do not need axes, so press [image: axes-none 24 h p] No Axes.
· Now [image: mode-point 24 h p] Add two Points on the circumference of the circle. Select them both, right click and choose “Line Segment”. Clearly, when there is only one slice, there are 2 pieces.
· Now [image: mode-point 24 h p] Add one more Point on the circumference of the circle. [image: Cursor] Select each pair of points in turn and create a “Line Segment” between them. There are 4 pieces.
· Now [image: mode-point 24 h p] Add one more Point on the circumference of the circle. Join this point to each of the other points with “Line Segments”. Count the regions, and there should be 8 pieces with 4 points.
· Ask the students to predict how many regions there will be if you add one more point. Now [image: mode-point 24 h p] Add one more Point on the circumference of the circle. Join this point to each of the other points with “Line Segments”. Count the regions, and there should be 16 pieces with 5 points.
· Ask the students to predict how many regions there will be with 6 points on the circumference. They will undoubtedly say 32, and ask them why they think this. It doubles each time; they are powers of 2; . When they go ahead and make the shape though, they will find that there are only 31 regions.
· This is an example of why we cannot generalise in mathematics, and we must prove results, as sometimes funny things happen. For your interest the formula is actually .
	· 2 Points
· 3 Points
· 4 Points
· 5 Points
· 6 Points

	[bookmark: _Toc375131659]Linear Programming
· A group of students is planning a day trip to London to raise money for charity. They have priced tickets at £10 for adults and £5 for children. The minibus they have hired can only seat 14 people. The event will only run if there are 10 or more people. There must be at least as many children as adults. What is the maximum profit?
· Set this investigation for students to attempt before looking at how to make use of Autograph.
· How could we write some inequalities to represent the information?
1. The minibus they have hired can only seat 14 people. This can be represented by 
2. The event will only run if there are 10 or more people. This can be represented by 
3. There must be at least as many children as adults. This can be represented by 
4. We also need to have  and 
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and deselect [image: axes-equalaspect 24 h p] Equal Aspect. [image: axes-edit 24 h p] Edit Axes so that  and  both go from -1 to 20. Before clicking OK, go to the “Labels” tab, and change the  variable to  and label to Children, and the  variable to  and the label to Adults.
· Now [image: add-equa 24 h p] Enter the five Equations above. This gives the region where all the constraints are satisfied.
· The total Profit is given by the formula . So [image: add-equa 24 h p] Enter this Equation into the Autograph page.  is a constant which can be changed, so use the [image: constantcon 24 h p] Constant Controller to change the total profit. We are looking for the maximum value of  so that the Objective Function (that is the line involving profit) still passes through the region. Once we have found the maximum profit, we can then use this to find the number of adults and children needed to get this profit.
	· Axes
· Constraints
· Profit Line

	[bookmark: _Toc375131660]Euler Line
· Open up a [image: page-new 2d 24 h p] New 2D graph page, and make sure [image: axes-equalaspect 24 h p] Equal Aspect is selected. We do not need axes, so press [image: axes-none 24 h p] No Axes. Be in [image: axes-snap10 24 h p] Tenths Snapping. [image: mode-point 24 h p] Add three Points anywhere on the page. [image: Cursor] Select them in pairs, right click and add a “Line Segment” to create a triangle. Select all three segments and change the [image: line-col 24 h p] Line Colour to blue.
· Ask students how to find the centre of a triangle. Hopefully several ideas will come up (the most useful is the centre of mass found simply by balancing the triangle on a single point). Discuss that there are in fact several different ways to define the centre of a triangle, and that they are going to investigate 4 of these.
· The Centroid (or mean or centre of mass) is the most used centre of a triangle as it is the centre of mass and so has wide ranging applications. To find this we find the midpoints of each side of the triangle and join these to the opposite vertex. 
· [image: Cursor] Select two corners of the triangle, right click and choose “Midpoint”. Now [image: Cursor] Select this midpoint and the third corner of the triangle, right click and choose “Straight Line”. Do the same for the other sides. What do you notice about the three lines? [image: Cursor] Select two of them, right click and choose “Solve Intersection”. [image: mode-point 24 h p] Add a Point to this intersection, right click and choose “Circle (Radius)”, giving it a radius of 0.1. Now [image: Cursor] Select the three lines joining midpoints to vertices, right click and “Hide Objects”.
· The Circumcentre also makes use of the midpoints of each of the sides. To find this we construct the perpendicular bisector of each side of the triangle. There is another way to find the circumcentre, which is to construct the unique circle which passes through all three vertices of the triangle, and find the centre of this circle.
· [image: Cursor] Select two corners of the triangle, right click and choose “Perpendicular Bisector”. Repeat this for the other two pairs of points.  What do you notice about the three lines? [image: Cursor] Select two of them, right click and choose “Solve Intersection”. [image: mode-point 24 h p] Add a Point to this intersection, right click and choose “Circle (Radius)”, giving it a radius of 0.1. Now [image: Cursor] Select the three perpendicular bisectors, right click and “Hide Objects”.
· The Orthocentre uses other perpendicular lines. To find this we construct the perpendicular line to each side passing through the opposite vertex.
· [image: Cursor] Select one vertex of the triangle and the opposite edge, right click and choose “Perpendicular Line”. Repeat this for the other two points and opposite edges.  What do you notice about the three lines? [image: Cursor] Select two of them, right click and choose “Solve Intersection”. [image: mode-point 24 h p] Add a Point to this intersection, right click and choose “Circle (Radius)”, giving it a radius of 0.1. Now [image: Cursor] Select the three perpendicular bisectors, right click and “Hide Objects”.
· The Midcircle is another circle defined on the triangle. To find this we find the midpoint of each side of the triangle and construct the unique circle through these three midpoints.
· [image: Cursor] Select two corners of the triangle, right click and choose “Midpoint”. Repeat for the other two pairs of corners so you have three midpoints. [image: Cursor] Select the three midpoints, right click and choose “Circle (3pts)”. Keeping the three midpoints selected, right click and choose “Centre of Circle (3 pts)”. [image: Cursor] Select this point, right click and choose “Circle (Radius)”, giving it a radius of 0.1. Now [image: Cursor] Select the circle, right click and “Hide Objects”.
· What do you notice about the four points you have constructed?
	· Euler Line Online Activity
· Triangle
· Centroid 1 
· Centroid 2
· Centroid Complete
· Circumcentre 1
· Circumcentre 2
· Circumcentre Complete
· Circumcentre Alt 1
· Circumcentre Alt 2
· Circumcentre Alt Complete
· Centroid, Circumcentre
· Orthocentre 1
· Orthocentre 2
· Orthocentre Complete
· Centroid, Circumcentre, Orthocentre
· Midcircle 1
· Midcircle 2
· Midcircle Complete
· Centroid, Circumcentre, Orthocentre, Midcircle
· Euler Line




	[bookmark: _Toc375131661]EXTRA FEATURES OF AUTOGRAPH
	Resources

	[bookmark: _Toc375131662]Export to Webpage
· In Autograph 3.3 there is the option to Export a whole page to a webpage. The benefit of this is that the activity is then usable by anybody for free (no need to have Autograph installed, they just require a freely available plugin). They are also impossible to destroy, as if students delete something accidently they can just refresh the page and the activity is back to the beginning. These can be great for setting students homework to explore a particular property which you can discuss in the following lesson.
· If you are interested in setting up a webpage for your students to use resources on, then there are several very good free web hosting sites. I use www.weebly.com and another well used one is www.wix.com 
· To export a page, simply make up the autograph file as you would normally, and once it is saved go to File->Export To Webpage… Go to the Options tab, and set the Width and Height of the activity you want to create. Then Click the Copy to Clipboard button.
· This code must be pasted as HTML on your website. Most hosts have a “HTML Code” or “Embed Code” option, and this is the item you want to use. Paste the code in this section.
· Now you must upload the file onto the page that you want the activity to appear on. Once it is uploaded you need to right click on it and “Copy Link Location”. This then needs to be pasted into two places within the code you have already pasted into the page. This should replace both instances of the file name in the code (but should remain in the quotes).
	· Video on Export to Webpage

	[bookmark: _Toc375131663]Copy to PPT or DOC
· Autograph is excellent for making various topics readily available for students to investigate using the dynamic nature of the software. However, sometimes you just want an image of a graph. For example: in a worksheet you want some blank axes; you want some printed notes for students to stick in their books; you want to use a graph with a PowerPoint.
· With Autograph by clicking in the main area and pressing Ctrl-C you copy the main page as a Bitmap image which can then be pasted (Ctrl-V) in almost any other programme (Word, PowerPoint, Notebook, online, etc).
	· Creating Worksheets Video

	[bookmark: _Toc375131664]Other Useful Things To Be Able To Do In Autograph
· One very useful tool in Autograph is the ability to Hide Objects. This can either be used to hide constructions of more complex shapes, or to allow you to reveal items later. To hide any object, simply select it, right click and choose “Hide Object”.
· You can also input images into an Autograph file simply by dragging and dropping them into the page. You can then set the transparency of the photo (double click on the image) and manage other properties easily.
	· Hiding Things! Video
· Images in Autograph Video

	[bookmark: _Toc375131665]Autograph Extras
· There are some excellent New Extras Pages in Autograph 3.3 which are pre-made interactive activities to use on a board or for students to play around with. They can be found in File->New Extras Page. There are 6 in total:
1. [image: Extras 1 24 h p] Area of a Circle – by splitting a circle into sectors derive the formula
2. [image: Extras 2 24 h p] Trigonometry – see the relationship between the unit circle and the trigonometric graphs
3. [image: Extras 3 24 h p] Monte Carlo
4. [image: Extras 4 24 h p] Dice Simulation – generates a random sample of dice throws in various scenarios, generating some data to look at
5. [image: Extras 5 24 h p] Confidence Intervals (Advanced Level only)
6. [image: Extras 6 24 h p] Poisson Grid (Advanced Level only)
	

	[bookmark: _Toc375131666]Online Resources
· There are lots of fantastic resources available online to help you find out more about Autograph and to use in the classroom ready-made. A selection of video tutorials, free Autograph Activities and various other useful bits of information can be found at the links shown.
	· Mr Barton’s Autograph Videos
· Videos from the Autograph Team
· Autograph Team Videos
· Mr Barton’s Online Autograph Activities
· Mr Barton’s Tutorial Worksheets
· TSM Resources
· Kangaroo Maths
· Interactive Maths

	
	




	[bookmark: _Toc375131667]OTHER TECHNOLOGY WORTH USING
	Resources

	[bookmark: _Toc375131668]QQI
· The QuickQuestion Interface (or QQI for short) is a concept I came up with a few years back. The basic premise is that each activity creates random questions on a particular topic and also provides the answer for checking afterwards.
· They are fantastic for use as starters or plenaries to a lesson, and are designed to work best with students working on Show Me boards so you can easily and quickly identify who has grasped the concept, and more importantly who hasn’t!
· There are over 50 different activities on a variety of topics from across the maths curriculum on my website, and each one instantly generates as many questions as you need, each one randomly produced.
· The other form of the activities are the 10QQI which produce 10 (or in some cases 5) random questions on a particular topic. Students must then enter the answer into the activity and it will tell them if they are correct or not. These can be excellent homeworks (with students using the Print Screen function on their computer to take a screen shot, or just printing the page when complete), great starters to get the whole class working quickly (get one student to enter the answers from the class) or as something for students to use in their revision to get extra questions to practise.
	· QQI Index
· 10QQI Index
· www.interactive-maths.com 

	[bookmark: _Toc375131669]Google Forms
· Google Forms are a fantastic way to collect data in schools (and other settings), and the real power of them is that they save all the response in a spreadsheet which can be easily analysed and managed. The uses of this are plenty with some examples being: collecting data from a class for a statistics project; managing entries to competitions; keeping track of sanctions and rewards; getting to know students. I have written a very thorough blog post on using Google Forms as well.
· One way that I have been using Google Forms to great effect is to set homeworks. Rather than give a class a worksheet with 20 questions, I create a form with the exact same questions on it, which I email to them. Because it is on the computer, students feel it is less like work and also there are less issues with organisation (they cannot lose it).
· This is great, and their answers are with me before the lesson. This means I can quickly see (using conditional formatting to highlight incorrect answers) if there were any major problems that I need to address in the next lesson. This is a vast improvement on addressing these issues in two or three lessons time when I have collected in their books and had a chance to mark them.
· Even better than this, following a few steps I have outlined in the blog post, you can also set up the form to email the student when they submit their answers, telling them how they did. Not only do you get feedback on how it went before the next lesson, they can also get instant feedback. You could even tell them they have to repeat the homework until they get at least so many correct.
	· Blog Post
· Number Types Display
· Simple Reply Code
· Reply Code with Marking
· Reply Code with Total Mark
· Reply Code with Corrections
· Conditional Formatting Code

	[bookmark: _Toc375131670]Random Name Generator and Excel
· Choosing who will answer each question is a key pedagogical point. Do you choose the ones who put their hands up, or pick on the quiet ones? You need to hear from everyone, but you can intimidate some of the more shy students if you just pick on them. One way to get round this is to not have any hands up in your lessons and choose students to answer each question. There are lots of fantastic ways to pick random students, but I have made a simple Excel Spreadsheet that chooses a random name from a class list. This is ideally projected on the board, and when you ask a question, you give the class a moment to think about it. Then you press the button to get a new random name to answer the question. As anyone could be selected, they must all be prepared to answer, and by having it visually on the board, they can see it. This forces all students to remain on their toes, and gets them all involved.
· Another use for Excel is to record data. For any tests that my classes do, I use the Test Mark Record to record their marks for each individual question. In its simplest form, it gives me a quick way to total their marks. But it also provides me with an in-depth review of how each student did and how each questions was as a whole. Using Conditional Formatting, certain things are highlighted: full marks on a question goes bright green; one standard deviation above the mean goes light green; one standard deviation below the mean goes a light red; the overall mean for a question goes orange if it is below 50%. This can then be used to identify which topics need to be reviewed, as well as giving an easy to use sheet to refer to for parents meetings.
· The other main use I make out of is to record the results a class gets in the past papers they do when working towards a qualification. The Exam Paper Record file takes the raw mark for a paper, and converts it into a grade using the actual grade boundaries from that year. This may need to be adapted depending on your exam board.
· There are lots of other things that can be done with Excel. The Tables activities are quick starters to get students practicing using directed numbers. They can be used on the board, or printed as a worksheet.
	· Random Name Generator
· Test Mark Record
· Exam Paper Record
· Tables
· Tables (no zeros)

	[bookmark: _Toc375131671]Diagnostic Questions
· Diagnostic Questions are the brain child of Craig Barton and Simon Woodhead. The principle is that each question has 4 possible answers, but each of the incorrect answers identifies a misconception. This means that from a quick look round the classroom not only can you identify who has made a mistake, but also what the problem is, very quickly. There are nearly 2000 questions already available, and any teacher can join and add their own questions, so the bank is growing continuously.
	· Diagnostic Questions
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